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Preface

This document introduces the features of the IBM® Sterling Store 
Inventory Management, Release 9.1. It also discusses known issues in 
this release and how to resolve them, if applicable.

Intended Audience
This document is intended for use by system administrators and 
managers who need to configure the Sterling Store Inventory 
Management, Release 9.1 to fit with their business practices. 

Structure
This document contains the following sections:

Chapter 1, "New Features"
This chapter introduces features of the Sterling Store Inventory 
Management, Release 9.1.

Chapter 2, "Known Issues"
This chapter provides a list of the known issues in this release.

Documentation
For more information about the Sterling Store Inventory Management 
components, see the following manuals:

Sterling Store Inventory Management: Release Notes

Sterling Selling and Fulfillment Suite: Applications Installation Guide
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Sterling Store Inventory Management: Deployment Guide

Sterling Selling and Fulfillment Suite: Applications Reference 
Implementation Guide

Sterling Store Inventory Management: Concepts

Sterling Store Inventory Management: Implementation Guide

Sterling Store Inventory Management: User Guide

Sterling Store Inventory Management: Localization Guide

Sterling Store Inventory Management: Javadocs

For more information about the IBM® Sterling Selling and Fulfillment 
Foundation components, see the following manuals:

Sterling Selling and Fulfillment Foundation: Release Notes

Sterling Selling and Fulfillment Foundation: Installation Guide

Sterling Selling and Fulfillment Foundation: Upgrade Guide

Sterling Selling and Fulfillment Foundation: Configuration Deployment 
Tool Guide

Sterling Selling and Fulfillment Foundation: Performance Management 
Guide

Sterling Selling and Fulfillment Foundation: High Availability Guide

Sterling Selling and Fulfillment Foundation: System Management 
Guide

Sterling Selling and Fulfillment Foundation: Localization Guide

Sterling Selling and Fulfillment Foundation: Customization Basics 
Guide

Sterling Selling and Fulfillment Foundation: Customizing APIs Guide

Sterling Selling and Fulfillment Foundation: Customizing Console JSP 
Interface for End User Guide

Sterling Selling and Fulfillment Foundation: Customizing the RCP 
Interface Guide

Sterling Selling and Fulfillment Foundation: Customizing User 
Interfaces for Mobile Devices Guide
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Sterling Selling and Fulfillment Foundation: Customizing Web UI 
Framework Guide

Sterling Selling and Fulfillment Foundation: Customizing Swing 
Interface Guide

Sterling Selling and Fulfillment Foundation: Extending the Condition 
Builder Guide

Sterling Selling and Fulfillment Foundation: Extending the Database 
Guide

Sterling Selling and Fulfillment Foundation: Extending Transactions 
Guide

Sterling Selling and Fulfillment Foundation: Using Sterling RCP 
Extensibility Tool Guide

Sterling Selling and Fulfillment Foundation: Integration Guide

Sterling Selling and Fulfillment Foundation: Product Concepts Guide

Sterling Warehouse Management System: Concepts Guide

Sterling Selling and Fulfillment Foundation: Application Platform 
Configuration Guide

Sterling Distributed Order Management: Configuration Guide

Sterling Supply Collaboration: Configuration Guide

Sterling Global Inventory Visibility: Configuration Guide

Catalog Management: Configuration Guide

Sterling Logistics Management: Configuration Guide

Sterling Reverse Logistics: Configuration Guide

Sterling Warehouse Management System: Configuration Guide

Sterling Selling and Fulfillment Foundation: Application Platform User 
Guide

Sterling Distributed Order Management: User Guide

Sterling Supply Collaboration: User Guide

Sterling Global Inventory Visibility: User Guide

Sterling Logistics Management: User Guide
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Sterling Reverse Logistics: User Guide

Sterling Warehouse Management System: User Guide

Sterling Selling and Fulfillment Foundation: Mobile Application User 
Guide

Sterling Selling and Fulfillment Foundation: Business Intelligence 
Operational Reports Guide

Sterling Selling and Fulfillment Foundation: Javadocs

Sterling Selling and Fulfillment Suite: Glossary

Parcel Carrier: Adapter Guide

Sterling Selling and Fulfillment Foundation: Multitenant Enterprise 
Guide

Sterling Selling and Fulfillment Foundation: Password Policy 
Management Guide

Sterling Selling and Fulfillment Foundation: Properties Guide

Catalog Management: Concepts Guide

Sterling Selling and Fulfillment Foundation: Pricing Concepts Guide

Sterling Selling and Fulfillment Foundation: Setting Up Quotes in 
Distributed Order Management

Sterling Sensitive Data Capture Server, Release 1.0: Configuration 
Guide

Sterling Sensitive Data Capture Server, Release 1.0: PA-DSS 
Implementation Guide

Sterling Selling and Fulfillment Foundation: Secure Deployment Guide

Sterling Business Center: Item Administration Guide

Sterling Business Center: Pricing Administration Guide

Sterling Business Center: Customization Guide

Sterling Business Center: Localization Guide

Sterling Field Sales: Deployment Guide

Sterling Field Sales: Implementation Guide

Sterling Field Sales: Localization Guide
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Sterling Field Sales: User Guide

Sterling Field Sales: Customization Guide

Visual Modeler: Administration Guide

Visual Modeler: Best Practices Guide

Visual Modeler: Implementation Guide

Visual Modeler: Installation Guide

Visual Modeler: Tutorial Guide

For a description of the various documents in the Sterling Store 
Inventory Management documentation set, see the Sterling Store 
Inventory Management documentation home page at:

<YFS_HOME>/documentation/SOP_doc_home.html

where <YFS_HOME> is the /Runtime directory under the folder where this 
application and Sterling Selling and Fulfillment Foundation are installed.

Conventions
The following conventions may be used in this manual:

Convention Meaning

. . . An ellipsis represents information that has been omitted.

< > Angle brackets indicate user-supplied input.

mono-spaced text Mono-spaced text indicates a file name, directory path, 
attribute name, or an inline code example or command.

/ or \ Slashes and backslashes are file separators for Windows, 
UNIX and LINUX operating systems. The file separator 
for the Windows operating system is "\" and the file 
separator for Unix and Linux systems is "/". The Unix 
convention is used unless otherwise mentioned.

<INSTALL_DIR> User-supplied location of the Sterling Multi-Channel Ful-

fillment Solution installation directory and Sterling Store 

Inventory Management installation directory. This is only 

applicable for Release 9.1
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1
New Features

Sterling Store Inventory Management is certified on Sterling Selling and 
Fulfillment Foundation, Release 9.1.

The Sterling Store Inventory Management application, Release 9.1, has 
been added to the Sterling Selling and Fulfillment Suite Applications 
Installer enabling the implementer to install the application from a single 
interface. 

For more information about the concepts and functionality of the Sterling 
Store Inventory Management, see the Sterling Store Inventory 
Management: Concepts Guide.
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2
Known Issues

This chapter describes the known issues that you may encounter in the 
following components of the Sterling Store Inventory Management, 
Release 9.1:

Prints and Reports

Receiving

IBM Sterling Store Inventory Management Configurator

IBM Sterling Store Inventory Management Client

Using the IBM Sterling Store Inventory Management with IBM 
Sterling Store

Shipping

Documentation

2.1 Prints and Reports
You may encounter the following issues when printing Reports or Prints.

130128 - You may encounter the following issues across the Reports 
and Prints provided with the Sterling Store Inventory Management:

– The column heading is not aligned with the column.

– In some reports or prints, both date and time is printed. In such 
situations, the time stamp wraps to the next line and is cut off in 
the hardcopy. Ignore the time stamp as it is irrelevant.

– If data is not available, the ’null’ value is displayed in some 
reports or prints.
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IBM Sterling Store Inventory Management Client

Solution/Workaround: None. 

2.2 Receiving
You may encounter the following issues when executing receiving tasks:

130550 - When you print the Receiving Discrepancy report for a 
Transfer Order shipment that has only one transfer order, the Transfer 
Order Number is not printed.

Solution/Workaround: Search for shipments. The Shipment List 
displays. From the list, select the applicable shipment and click the 
View Details button. The Transfer Order number associated with the 
shipment displays.

2.3 IBM Sterling Store Inventory Management 
Configurator

175710 - In Sterling Store Inventory Management Configurator, the 
version information in the Help > About pop-up window is truncated.

Solution/Workaround: None.

2.4 IBM Sterling Store Inventory Management 
Client

You may encounter the following issues with the behavior of the client 
application:

126392 - In all list screens, after you select a record from the list 
and press the Enter key, you cannot view the details of the selected 
record.

Solution/Workaround: Click the Proceed button or use the hot key 
specified for the Proceed button.
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2.5 Using the IBM Sterling Store Inventory 
Management
with IBM Sterling Store

You may encounter the following issues in the client application when 
using Sterling Store Inventory Management with Sterling Store. Perform 
the actions mentioned in the Solution/Workaround to fix the issues:

175133 - The File menu and the Help menu are displayed in the 
Navigator.

Solution/Workaround: 

In a single schema setup, connect to your database and run the 
<INSTALL_DIR>/database/FactorySetup/sop/som_sim_scripts/ 
sop_delete_menus.sql SQL script.

In a multischema setup, connect to your database where the 
configuration schema is present and run the 
<INSTALL_DIR>/database/FactorySetup/sop/som_sim_scripts/ 
sop_delete_menus.sql SQL script. 

175156 - In the Navigator, only the "Shipping" menu group has a 
mnemonic for the letter "S". This is inconsistent with the other menu 
groups in the Navigator.

Solution/Workaround: None.

175661 - Sterling Store Inventory Management-specific screens 
display the Show Criteria/Hide Criteria button to show or hide the 
criteria panel. However, Sterling Store-specific screens display +/- 
button for the same function. This inconsistency must be rectified.

Solution/Workaround: None.

180122 - When you create a shipment for a store, the status of the 
shipment is set to "Shipment Created" instead of 
"ReadyForBackroomPick".

Solution/Workaround: Perform the following steps to fix this issue:

1. Open the Applications Manager. 

2. Navigate to Outbound Shipment Repository > Create Shipment 
Transaction.

3. Open the event handler for the ON_SUCCESS event.
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Shipping

4. Delete the existing "Is Store" condition.

5. Add the "Is Store" condition from the repository.

6. Click the Save button.

182213 - When you create a shipment for a store, the "Status is not 
a valid pipeline pickup status for the transaction" error message is 
displayed.

Solution/Workaround: Perform the following steps to fix this issue:

1. Open the Applications Manager.

2. Navigate to Outbound Shipment Repository > Pipeline 
Determination > My Rule.

3. Delete the existing "Is Store" condition.

4. Add the "Is Store" condition from the repository.

5. Click the Save button.

243094 - When a user launches the Sterling Store tasks, an error 
message, "Rule not found" is displayed.

Solution/Workaround: Run the following script from 
<INSTALL_DIR>/bin:

For Windows:

sci_ant.cmd -f  ycd_install_with_SIM.xml -logfile 
<logfile>

For Linux/Unix:

./sci_ant.sh -f ycd_install_with_SIM.xml -logfile 
<logfile>

2.6 Shipping
You may encounter the following issues when executing the shipping 
tasks:

129523- When you reprint a Pick Ticket, the Sterling Store Inventory 
Management application does not display a success message.

Solution/Workaround: None.
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2.7 Documentation
The following issues are present in the Sterling Store Inventory 
Management documentation:

130411 - In the Sterling Selling and Fulfillment Foundation: 
Javadocs, the description of the syncStoreRule API is incorrectly 
defined as "synchronize the count strategies".

Solution/Workaround: None.

201857 - The Sterling Store Inventory Management: User Guide 
must be updated with the information that the application permits a 
user to blank out a row or an entire sheet in the Record Physical 
Count screen and the Rectify Count Sheet.

Solution/Workaround: None.



8   Release Notes

Documentation



   9

Notices

This information was developed for products and services offered in the 
U.S.A. 

IBM may not offer the products, services, or features discussed in this 
document in other countries. Consult your local IBM representative for 
information on the products and services currently available in your area. 
Any reference to an IBM product, program, or service is not intended to 
state or imply that only that IBM product, program, or service may be 
used. Any functionally equivalent product, program, or service that does 
not infringe any IBM intellectual property right may be used instead. 
However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject 
matter described in this document. The furnishing of this document does 
not grant you any license to these patents. You can send license 
inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

For license inquiries regarding double-byte character set (DBCS) 
information, contact the IBM Intellectual

Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
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Legal and Intellectual Property Law

IBM Japan Ltd.

1623-14, Shimotsuruma, Yamato-shi

Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or 
any other country where such provisions are inconsistent with 
local law: INTERNATIONAL BUSINESS MACHINES CORPORATION 
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. Some states do

not allow disclaimer of express or implied warranties in certain 
transactions, therefore, this statement may not apply to you. 

This information could include technical inaccuracies or typographical 
errors. Changes are periodically made to the information herein; these 
changes will be incorporated in new editions of the publication. IBM may 
make improvements and/or changes in the product(s) and/or the 
program(s) described in this publication at any time without notice. 

Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of 
those Web sites. The materials at those Web sites are not part of the 
materials for this IBM product and use of those Web sites is at your own 
risk. 

IBM may use or distribute any of the information you supply in any way 
it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between 
independently created programs and other programs (including this one) 
and (ii) the mutual use of the information which has been exchanged, 
should contact:

IBM Corporation

J46A/G4

555 Bailey Avenue

San Jose, CA__95141-1003
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U.S.A. 

Such information may be available, subject to appropriate terms and 
conditions, including in some cases, payment of a fee. 

The licensed program described in this document and all licensed 
material available for it are provided by IBM under terms of the IBM 
Customer Agreement, IBM International Program License Agreement or 
any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating 
environments may vary significantly. Some measurements may have 
been made on development-level systems and there is no guarantee that 
these measurements will be the same on generally available systems. 
Furthermore, some measurements may have been estimated through 
extrapolation. Actual results may vary. Users of this document should 
verify the applicable data for their specific environment. 

Information concerning non-IBM products was obtained from the 
suppliers of those products, their published announcements or other 
publicly available sources. IBM has not tested those products and cannot 
confirm the accuracy of performance, compatibility or any other claims 
related to non-IBM products. Questions on the capabilities of non-IBM 
products should be addressed to the suppliers of those products. 

All statements regarding IBM's future direction or intent are subject to 
change or withdrawal without notice, and represent goals and objectives 
only.

This information is for planning purposes only. The information herein is 
subject to change before the products described become available. This 
information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples 
include the names of individuals, companies, brands, and products. All of 
these names are ficticious and any similarity to the names and addresses 
used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source 
language, which illustrate programming techniques on various operating 
platforms. You may copy, modify, and distribute these sample programs 
in any form without payment to IBM, for the purposes of developing, 
using, marketing or distributing application programs conforming to the 
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application programming interface for the operating platform for which 
the sample programs are written. These examples have not been 
thoroughly tested under all conditions. IBM, therefore, cannot guarantee 
or imply reliability, serviceability, or function of these programs. The 
sample programs are provided "AS IS", without warranty of any kind. 
IBM shall not be liable for any damages arising out of your use of the 
sample programs. 

Each copy or any portion of these sample programs or any derivative 
work, must include a copyright notice as follows:

© IBM 2011. Portions of this code are derived from IBM Corp. Sample 
Programs. 
© Copyright IBM Corp. 2011. 

If you are viewing this information softcopy, the photographs and color 
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered 
trademarks of International Business Machines Corp., registered in many 
jurisdictions worldwide. Other product and service names might be 
trademarks of IBM or other companies. A current list of IBM trademarks 
is available on the Web at “Copyright and trademark information” at 
www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either 
registered trademarks or trademarks of Adobe Systems Incorporated in 
the United States, and/or other countries.

IT Infrastructure Library is a registered trademark of the Central 
Computer and Telecommunications Agency which is now part of the 
Office of Government Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel 
Centrino logo, Celeron, Intel Xeon, Intel SpeedStep, Itanium, and 
Pentium are trademarks or registered trademarks of Intel Corporation or 
its subsidiaries in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, 
other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks 
of Microsoft Corporation in the United States, other countries, or both.

www.ibm.com/legal/copytrade.shtml
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ITIL is a registered trademark, and a registered community trademark of 
the Office of Government Commerce, and is registered in the U.S. Patent 
and Trademark Office.

UNIX is a registered trademark of The Open Group in the United States 
and other countries.

Java and all Java-based trademarks and logos are trademarks or 
registered trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, 
Inc. in the United States, other countries, or both and is used under 
license therefrom.

Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are 
trademarks of HP, IBM Corp. and Quantum in the U.S. and other 
countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise, 
Gentran®, Gentran:Basic®, Gentran:Control®, Gentran:Director®, 
Gentran:Plus®, Gentran:Realtime®, Gentran:Server®, 
Gentran:Viewpoint®, Sterling Commerce™, Sterling Information 
Broker®, and Sterling Integrator® are trademarks or registered 
trademarks of Sterling Commerce, Inc., an IBM Company.

Other company, product, and service names may be trademarks or 
service marks of others.
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